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Genesys Interactive Insights 8.5
Deployment Guide
Welcome to the Genesys Interactive Insights Deployment Guide. This document introduces you to the
configuration, installation, setup, and start procedures that are relevant to the setup of Genesys
Interactive Insights (GI2) universes and the operation of GI2 reports. This document is valid only for
the 8.5.x releases of GI2. For versions of this document that have been created for other releases of
these products, visit the Genesys Customer Care website, or request the Documentation Library DVD,
which you can order by email from Genesys Order Management.

About GI2

GI2 provides reports that summarize contact center activity and an entire universe of supporting
elements (GI2_Universe). Reports display contact center activity using a variety of visual devices,
such as those shown in the Figure Example Report.

Tip

Example Report

As with most illustrations in this document, the Figure shown here is a thumbnail; click
it to view a larger version.
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New In This Release
This section describes the changes that have been incorporated within this guide since the 8.5.0
release of GI2.

For information about what's new in the software, see the Genesys Interactive Insights Release
Notes.

Genesys Interactive Insights 8.5.000.02

This is the initial release of this new document.

Other Changes

Changes pertaining to the the day-to-day operation of GI2 are described in the Genesys Interactive
Insights User's Guide. Also, refer to the Genesys Interactive Insights Universe Guide for information
about the new reports and other new universe elements that were introduced or updated within the
8.5.x releases.

New In This Release
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Overview: What is GI2 All About?
Genesys Interactive Insights (GI2) uses the data stored in a Genesys Info Mart database and presents
that data in readable reports to enable business and contact center managers to make better
business decisions for streamlining operations, reducing costs, and providing better services. This
page provides an overview of the relationships between the components that are required for GI2
operation:

Presentation Layer for Genesys Info Mart

BI Architecture Using GI2

GI2 is the presentation layer that Genesys has designed for the business-like interpretation of source
data that is collected and stored by Genesys Info Mart. GI2 for Genesys Info Mart provides a universe
of over 600 defined agent-, agent-session-, campaign-, and queue-type measures and over 40
reports that summarize contact center activity. This functionality is delivered with the power of SAP
BusinessObjects Business Intelligence Platform (BI) 4.x. The figure BI Architecture Using GI2
illustrates how the components that contribute to GI2 operation fit together. Refer to the Genesys
Interactive Insights Universe Guide for detailed information about the Genesys-provided reports and
measures.

Genesys Info Mart

GI2 pulls data directly from the Info Mart database; no other Genesys products are required in order
for the GI2 reports to be scheduled, maintained, opened, and run. Only the Genesys Info Mart RDBMS
(with RAA), and SAP BusinessObjects Business Intelligence Platform (BI) software, must be in
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operation. However, from a practical standpoint, the Info Mart database should also be populated
regularly with meaningful data that is sourced from contact center activities that are directed,
monitored, and recorded by a number of Genesys products. The Genesys Info Mart Server extracts,
transforms, and loads contact center data into fact tables at the most atomic, interaction
level—enabling maximum flexibility of data interpretation. This low level of detail is good for tracking,
verifying, and determining the contributing grains, but such detail is rarely useful for reporting and
analysis of the performance of various contact center resources over a span of time, even as little as
an hour.

The Reporting and Analytics Aggregates (RAA) engine—an optional Genesys Info Mart component
that is mandatory for GI2 operation—compiles data from these fact tables and stores it within several
aggregate views, based on the appropriate aggregation level (subhour [i.e., 30-minute], hour, day,
and month) and type of data (disposition or interval). Refer to the Genesys Interactive Insights User’s
Guide for information about these measure types. Use of these aggregates drastically improves query
performance when you run the GI2 reports.

The Info Mart schema was updated significantly in the Genesys Info Mart 8.x releases to enable
measurement of threaded interactions, among other features. The GI2 8.x universe and reports
reflect the changes and function properly when they are paired with an Info Mart that is based on the
appropriate Genesys Info Mart 8.x schema. The table Interoperability of Software Components
provides this mapping of GI2 release to Genesys Info Mart schema. Refer to the Genesys Interactive
Insights Universe Guide for a list of the underlying Genesys Info Mart source tables of each GI2
report, as well as either:

• The Genesys Info Mart Reference Manual for your particular RDBMS type (available from Genesys Info
Mart documentation), for in-depth descriptions of the fact and dimension Info Mart tables and their
columns.

• The Reporting and Analytics Aggregates Reference Manual, for in-depth descriptions of aggregation
tables and their columns.

GI2 supports the generation of reports from Genesys Info Mart data sources that are managed by the
following RDBMSs:

• PostgreSQL 9.3.
• Oracle 11g and 12c.
• Oracle 11g RAC.
• Microsoft SQL Server 2008 and 2012.

Refer to the Genesys Interactive Insights page in the Genesys Supported Operating Environment
Reference Guide for additional information about support and the Genesys Interoperability Guide for
the minimum required releases of the necessary components.

Overview: What is GI2 All About?
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SAP BusinessObjects

Components of the BI Architecture

SAP BusinessObjects Business Intelligence Platform (BI 4.1) is the business intelligence software that
powers GI2 8.5. The tools that are furnished within these software suites enable you easily and
quickly to produce meaningful results, and provide analysis for more effective decision making. A full
BI installation contains all of the components shown in the Figure Components of the BI
Architecture.

Deploying GI2

To use GI2 you must perform, at minimum, two independent installations. A third independent
installation is required if you choose to install BI software apart from the installation of GI2:

• Genesys Info Mart 8.5—You must have the Genesys Info Mart 8.5 CD (or image) to install Info Mart 8.5.
Please refer to:
• The Genesys Info Mart Deployment Guide and Genesys Info Mart Deployment Procedure (available

from docs.genesys.com) for instructions on installing this product.
• Readying Genesys Info Mart for Aggregation for additional setup information.
• The GI2 Release Advisory (available from docs.genesys.com) for information about the minimum

required version of Genesys Info Mart software.

• SAP BusinessObjects Business Intelligence Platform—Refer to BO/BI documentation for instructions on
manually installing this software. Both silent and manual installations require the SAP BusinessObjects
Business Intelligence Platform CD (or image).

• GI2 8.5—You must have the Genesys Interactive Insights 8.5 CD (or image) to install the GI2 universe
and reports. Refer to How Do I Install GI2? for deployment instructions, and After Installation, What
Additional Steps Do I Perform? for post-GI2 setup. When you deploy GI2, RAA is included with the GI2
installation package. You should not install RAA independently prior to GI2 installation. Refer to the
Reporting and Analytics Aggregates documentation for information about RAA.

Unlike most other Genesys products, the GI2 application is not configured within Configuration
Server.

Overview: What is GI2 All About?
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User Accounts and Security

User accounts pertinent to GI2 are actually configured in several environments. To work in GI2,
ensure that your accounts are configured as follows:

• Info Mart database users—These users must have necessary permissions to link the GI2 universe
with a data source (your Info Mart database). This includes the ability to configure information that is
stored in an internal BusinessObjects database as an attribute of the GI2 universe (including the
following Info Mart database connectivity parameters: driver type, server name, database name,
and user name).

• Genesys Info Mart users—These users must have access to Genesys Info Mart Manager and be
familiar with operation of general Genesys Info Mart functionality. This access enables you to manage
the aggregation process that relies on Genesys Info Mart internal processes. The aggregation engine
(RAA) is driven by Job_AggregateGIM, a job that is managed by the Genesys Info Mart Scheduler and
is accessible thru the Genesys Info Mart Manager.

• GI2 users—These are actually SAP BI 4.1 user accounts, and must have rights to manage GI2 objects
and corresponding BI objects, including the ability to:
• Use Web Intelligence, create, delete, and edit reports, and view the underlying SQL.
• Schedule reports and save them in other formats, such as PDF and Microsoft Office Excel.

Overview: What is GI2 All About?
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What BO/BI Components Must I Install?
SAP BusinessObjects (BO) software is an optional component of Genesys Info Mart, but is required for
the operation of Genesys Interactive Insights (GI2). Refer to SAP BusinessObjects Business
Intelligence Platform 4 (BI 4.1) documentation for additional installation and upgrade instructions.

Access BO/BI Documentation from the following sources:

• From the SAP BusinessObjects Business Intelligence Platform Documentation CD.
• If you are a direct SAP customer, from the SAP website.
• If you obtained BI software through Genesys, from the SAP website.

GI2 does not require all available BI components: this page describes only those components that are
required for GI2 operation.

Prerequisites to BI Software Installation

Prior to beginning the installation of BI 4.x, ensure that you have met the following prerequisites:

• Acquire the appropriate installation package, which is provided either directly from SAP or from
Genesys.

• Ensure that no prior BI software versions pre-exist on your host. If you have a prior version of BI 4.x
installed, you should upgrade it, rather than install it anew. Refer to the relevant BI 4.x Update Guide
for instructions.

• Ensure that your operating system is a supported version. Supported platforms are described in BI
documentation. Note that BI supports a wider range of platforms than does GI2.

• Ensure that your environment meets or surpasses the minimum hardware and sizing requirements
described in BI documentation for the various BI servers. For example, BI 4.1 requires 16 GB RAM and
up to 14 GB hard-disk space.

• Ensure that your environment meets or surpasses the minimum software requirements for the various
server products described in BI documentation. Note that BI software supports connectivity to a wider
range of RDBMSs than does Genesys. This release of GI2 restricts RDBMS support to those that
currently are supported by Genesys Info Mart. More information is available in the Genesys Interactive
Insights section of the Genesys Supported Operating Environment Reference Guide.

Additional notes for UNIX platforms

• To install BI, you must not be logged on as the root user.
• Ensure that the LOCALE setting of the UNIX shell is set to Unicode encoding (en_US.UTF-8 for Solaris,

en_US.utf8 for Linux). For RedHat Enterprises Linux operating systems, disable the Security Enhanced
Linux feature. The standard RHE installation enforces this feature by setting SELINUX=enforcing in the
/etc/sysconfig/selinux file. You must set this parameter to disabled and reboot the server in order

What BO/BI Components Must I Install?
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for a BI installation to be successful.
• On Linux 5.x installations, ensure that the first line of the etc/hosts file contains the default string:

127.0.0.1 localhost.localdomain localhost.ER321049511 The installation routine varies slightly
depending on your UNIX platform, and can take more than an hour to complete on any platform.

Obtaining Access Parameters
Make note of the access parameters that you specify when setting up the Central Management
Server (CMS) during BI software installation. Later, when you install GI2, you will need the BI
administrator’s user name and password, as well as the host and port information, if the default
values were not chosen. The defaults are:

• User name: Administrator (This user must be named Administrator. Another user account with
administrative permissions will not suffice.)

• Password: A suitable password consisting of a combination of a upper case letters, lower case letters,
and numbers. A blank password is not permitted.

• Host: Name of your computer
• Port: 6400 (See Retrieving the CMS Port Value.)

Retrieving the CMS Port Value

Procedure: Retrieving the CMS Port Value
Purpose: Use this procedure to retrieve the port number from the Central Configuration
Manager.

Steps

1. Open the Central Configuration Manager, and right-click the Server Intelligence Agent
application.

2. From the context menu that appears, select Properties, and then select the Startup tab.
3. Record the CMS port number, which appears in the Local CMS Servers frame, as shown in the

What BO/BI Components Must I Install?
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Figure Retrieving the CMS Port Value.

Important
The BO/BI license that Genesys provides is a restricted license. Refer to the licensing
agreement for details on what data you can access when using this software.

Required BI Components

The BI 4.x installation wizard gives you the opportunity to select which components to install. The
following are required for GI2 operation:

• Client Components: Import Wizard, Information Design Tool, Web Intelligence Rich Client, Developer
Components (BOE Java SDK, BOE Web Services, BOE .Net SDK).
Note: With the exception of BOE Java SDK and BOE Web Services, all client components are available
only on Microsoft Windows platforms.

• Web Tier Components: Select any of the listed components.
• Server Components: Central Configuration Manager (Microsoft Windows only), Central Management

Server, Event Server, Job Servers (Publication, Destination, List of Values, Program, Adaptive), Report
Application Server, Input File Repository Server, Output File Repository Server, Web Intelligence
Processing Server, Adaptive Processing Server, Dashboard and Analytics Servers, Auditing Reports and
Universes.

• Database Access: Microsoft SQL Server, Oracle, PostgreSQL.
Note: For database access, GI2 supports connectivity to the listed RDBMS, as supported by Genesys
Info Mart. For information about the specific supported RDBMS versions, refer to the Genesys
Supported Operating Environment Reference Guide.

Installing BI software

BI 4.x software is provided among the software that is bundled with GI2. Instructions for installing the
software are provided in BusinessObjects documentation—specifically, within the following
documents: Installation Guide for Windows, Installation Guide for UNIX.

In most cases, you will install only the components required for GI2 operation. Optionally, you can
install the complete version of BI 4.x if you want more functionality than is provided by the standard
Genesys configuration of BI for GI2, including tools that GI2 does not require (for example, Crystal
Reports). This standard configuration specifies the following:

• English language

What BO/BI Components Must I Install?
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• Tomcat application server
• Sybase SQL Anywhere 12.0.1 (installed by default as the DBMS for the Central Management Server

(CMS), for all platforms)
• Administrator, as the name of the CMS administrative user

Important
Deployment of the full version of BI still binds you to the limited licensing agreement
regarding its use, which is described in the Genesys Interactive Insights User’s Guide.

Setting up the BI Environment

Refer to the Business Intelligence Platform Administrator Guide to set up the administrative functions
for using BI software, including the following:

• Setting rights.
• Managing user accounts and groups.
• Managing data sources and connections.
• Managing objects.
• Scheduling objects.
• Managing profiles.
• Row-level and column-level security.

The reports and universe that are deployed later during GI2 installation are initially available only to
the following users:

• Administrator
• Developer
• Editor
• Viewer
• Basic

You can create other users and configure their roles and access to the reports and to the universe in
accordance with your company’s policy. For multi-tenant environments, consider creating separate
groups (at minimum) for each tenant, to align with the way in which universe connections to the
Genesys Info Mart should be defined. Refer to Manually Setting Up GI2 Access Levels for information
about the GI2 groups and users that are provided in the GI2 BusinessObjects archive. You can
disregard preferences and permissions for components that are not required for GI2 operations—such
as Crystal Reports and Xcelsius.
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How Do I Install GI2?
After you have installed SAP BusinessObjects Business Intelligence Platform (BI 4.1) software, use the
instructions on this page to install Genesys Interactive Insights (GI2)

Before You Begin

GI2 requires a connection to a Genesys Info Mart release 8.5 database. Although the regular
population of the database is not required for GI2 installation, GI2 can provide meaningful reports
only if the database is regularly populated by a Genesys Info Mart 8.5 application. Genesys Info Mart
must be properly configured and installed before GI2 runs the aggregation process.

• The Genesys Info Mart documentation set describes how to deploy and configure Genesys Info Mart.
• The Reporting and Analytics Aggregates (RAA) documentation set describes the aggregation.
• The BO/BI Documentation provides information about how to use the various BO/BI tools.

Overview of the Installation Routine

The installation routine offers you choices:

• copy-only: Copies the installation script and supporting files to a designated location for manual
deployment at a later time. Choose this option if you require greater control and more visibility into the
inner workings of the installation routine. In addition to copying the installation script and supporting
files, the copy-only option:
• Copies the \agg folder, which contains RAA, to the Interactive Insights root folder.
• Updates the program registry on Microsoft Windows platforms.

• deploy-now: Installs GI2 immediately. In addition to copying the installation script and supporting files,
the deploy-now option:
• Copies the \agg folder, which contains RAA, to the Interactive Insights root folder.
• Imports the GI2 universe, folder, reports, connection, measure maps, and PDF documents into the BI

repository.
• Defines different users and groups within BI 4.1.
• Updates the program registry on Microsoft Windows platforms.

Refer to What Application Files Are Installed? for the names of the application files that are deployed.

Important

How Do I Install GI2?
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Unlike most other Genesys applications, GI2 is not configured as an application within
Genesys Configuration Server, nor is it started (or stopped) by using the Genesys
Solution Control Interface.

Prerequisites

You can install multiple instances of GI2 on the same host. To install GI2, the following prerequisites
must be met:

• BI software must be installed on the same host where GI2 will be installed. Refer to What BI
Components Must I Install? for additional information.

• You must connect to the BusinessObjects Central Management Server (CMS) as Administrator and the BI
servers must be running. Consider running the Repository Diagnostic Tool and addressing any issues
encountered.

• You must have the GI2 8.5 installation package and the BI installation package.
• Your operating system version must be one of the following (to support BI 4.1):

• Sun SPARC: Solaris SPARC 64-bit 10
• Red Hat: Red Hat Enterprise Linux 64-bit 5.0, Red Hat Enterprise Linux 64-bit 6.x
• Microsoft: Windows Server 64-bit 2008, Windows Server 64-bit 2012
• IBM: AIX Power PC 64-bit 6.1, AIX Power PC 64-bit 7.1

In addition, before you operate the GI2 reports, you must have access to an Info Mart schema that is
populated by Genesys Info Mart. Refer to the Genesys Info Mart Deployment Guide or the Genesys
Migration Guide for information that pertains to configuring, installing, or upgrading these products.
Although the installation routine does not check for access to the Info Mart database, the BI license
that Genesys provides requires such access for use of the software.

Backing Up Prior Universes

To preserve any customizations that you made to a pre-existing GI2 universe, Genesys recommends
that you back up any GI2 universes that might exist in the BI repository before you install GI2; the
installation routine might overwrite a pre-existing GI2_Universe, regardless of the folder in which it
resides. One way to accomplish this is to export the universe to an LCMBIAR file and store it for
safekeeping. Refer to the BO/BI documentation for instructions on how to export the universe to
these formats.
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Installing GI2

Use the procedures in this section to install GI2.

Procedure: Installing GI2 on UNIX
Purpose: Use this procedure to install GI2 on UNIX. Note that BI 4.1 software must already be
installed so that the GI2 universe, folder, and reports can be deployed to the BI repository.

Steps

1. In the directory into which you copied the GI2 installation package (or from the Genesys
Interactive Insights DVD), locate the install.sh shell script.

2. Run the following script from the command line: sh install.sh
3. When prompted, choose whether to copy only the GI2 installation files: y or n. If you select y, the

installation routine copies the files that are needed to install GI2 manually to the current
directory. You will have to manually deploy the GI2 universe and reports to the BI repository and
set up groups and user permissions.
If you select n, continue to Step 4. If you select y, proceed to Step 9.

4. When prompted, choose whether to deploy GI2: y or n.
If you selected n at Step 3, select y now.

5. Type the path where BI 4.1 is installed. This path cannot contain spaces.
6. Specify the host for the BI CMS or accept the default, which is the name of the local computer.

The host name you specify cannot contain underscores (_), periods (.), or slashes (/ or \)
7. Type the CMS port, or accept the default (6400).
8. Type the password for the BI Administrator.
9. Type the full path of the destination directory for GI2 installation files. This path must not contain

spaces.
The installation routine verifies that a valid path was entered (and creates the path, if does not
exist), extracts GI2 archives using the destination directories that were specified, and loads the
GI2 reports and universe into the BI repository. If you selected y in step 3, and the installation
routine fails to connect, the installation halts, and you must resume the installation manually as
described in Manually Running the GI2 Installation Script.

See What Application Files Are Installed? for a description of the files that are deployed. For
greater security, Genesys recommends that you edit the gi2_setenv.sh file to remove the
password.
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Procedure: Installing GI2 on Windows
Purpose: Use this procedure to install GI2 on Windows platforms. Note that BI 4.1 software
must already be installed so that the GI2 universe, folder, and reports can be deployed to the
BI repository.

Steps

1. From the Genesys Interactive Insights CD or image, double-click the setup.exe file. The
installation routine checks the Windows registry for an existing GI2 installation before it displays
the Welcome page.

2. On the Welcome page, click Next.
3. On the Installation Mode page, choose one of the following options: Deploy Genesys

Interactive Insights or Copy Genesys Interactive Insights files only.
4. Click Next. If you selected Copy Genesys Interactive Insights files only, skip to Step 6.
5. On the BusinessObjects Enterprise Central Management Server page, type the password

of the CMS Administrator, and click Next. The installation routine prepopulates default values in
the Host name and Port fields. Enter appropriate values, or accept the default values. The host
name that you specify cannot contain underscores (_), periods (.), or slashes (/ or \).

6. On the Choose Destination Location page, specify where the installation routine is to install
GI2, or accept the default location, and click Next. The default location is:
C:\Program Files (x86)\GCTI\Genesys Interactive Insights

7. On the Ready to Install page, click Install.
The installation routine:
a. Extracts the GI2 archives from the destination directory that you specified in Step 5.
b. Adds keys to the registry.
c. Loads the GI2 reports, universe, users, groups, and rights (if you selected the Deploy

Genesys Interactive Insights option).
d. Scans the BI repository for existing components.
e. Exits.

Next Steps

See What Application Files Are Installed? for a description of the files that
are deployed. For improved security, Genesys recommends that you edit
the gi2_setenv.bat file to remove the password.

Manually Running the GI2 Installation Script
You can use the files that are deployed by the installation routine to import the GI2 universe, folder,
reports, users, groups, and rights. Manually run the installation in any of the following circumstances:
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• To deploy the universe and reports to a different BI environment.
• If you selected the Copy Genesys Interactive Insights files only option from the Genesys

Installation Wizard.
• To re-import the universe, folder, and/or reports into your environment.

Important
Before re-importation, delete the GI2 universe, folder, connection, user groups, and default users (that is,
perform Step 3 of the procedure Additional Manual Steps to Finish the Uninstall).

• If the installation of GI2 using the Genesys Installation Wizard was unsuccessful. In this case, follow the
procedure Before Manually Installing GI2 after a Failed Installation Attempt.

Procedure: Before Manually Installing GI2 after a Failed
Installation Attempt
Purpose: If you attempted to install GI2 using the Genesys Installation Wizard, and the
installation was not successful, complete this procedure before attempting to manually install
GI2.

Steps

1. Verify that the Prerequisites are met.
2. Check for errors using the Central Management Console (Promotion Management >

Promotions Jobs > 8.5.0).
3. Correct the error.

If the Genesys Installation Wizard was unable to access CMS, ensure that you have specified
correct connectivity parameters:
a. Open either gi2_setenv.bat (on Windows platforms) or gi2_setenv.sh (on UNIX platforms).
b. Set the correct parameters.
c. Save the file.

Tip: You can retrieve the port number from the Central Configuration Manager by following the
steps in Prerequisites (Obtaining Access Parameters).

Procedure: Manually Installing GI2
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Purpose: To manually deploy GI2. For information about situations where you might use this
method, see Manually Running the GI2 Installation Script.

Steps

1. Specified connectivity parameters:
a. Open either gi2_setenv.bat (on Windows platforms) or gi2_setenv.sh (on UNIX platforms).
b. Set the connectivity parameters.
c. Save the file.

Tip: You can retrieve the port number from the Central Configuration Manager by following the
steps in Prerequisites (Obtaining Access Parameters).

2. At the command prompt, run the script: gi2_deploy_unv_rep.bat (Windows) or
gi2_deploy_unv_rep.sh (Unix).
The GI2 universe, reports, users, user groups, and permissions are deployed.

3. For improved security, Genesys recommends that you edit the gi2_setenv.bat file to remove
the password.

Manually Importing Objects and Data Elements
The GI2 universe contains the data elements and business objects required for running the GI2
reports. These data elements include classes, dimensions, measures, and conditions, as well as the
reports themselves. Please refer to the Genesys Interactive Insights Universe Guide for descriptions
of universe elements. The installation routine automatically imports the GI2 universe, folders, reports,
users, groups, and rights into your BI environment. Use the information in this section to re-import
these objects and data elements. This is useful, for instance, if:

• The installation does not finish.
• You delete the universe from the Central Management Console in error.
• To redeploy the same universe, reports, and folders to your existing environment.
• To deploy the universe, reports, folders, users, groups, and rights to more than one environment.

Procedure: Importing Objects and Elements using CMC
Purpose: This section describes how to manually import the GI2 universe, folders, reports,
users, groups, and rights into BI 4.1 using the Central Management Console (CMC). For more
information about using CMC, see the BI Documentation.
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Steps

1. In CMC, in the Manage list, click Promotion Management.
2. Click New Job.
3. On the New Job dialog box, enter a Name, and optionally enter text in the Description and

Keywords fields.
4. In the Source drop-down list, choose Login to a new CMS and specify the system from which

to load the LCMBIAR file, and enter the associated (Administrator) User Name and Password, and
click Login.

5. In the Destination drop-down list, choose Login to a new CMS and specify the destination
CMS where you wish to save the new LCMBIAR file, enter the associated (Administrator) User
Name and Password, and click Login.

6. Click Create.
7. On subsequent pages, select the objects to import.

Next Steps

You can optionally migrate your universe from UNV to UNX using the steps
described in Migrating Custom Universe and Reports.

Universe Contents

If you have imported the GI2 universe successfully, your BI environment will contain the following:

The following groups:

Interactive Insights report developers
Interactive Insights report editors
Interactive Insights report viewers
Interactive Insights report basic
Interactive Insights access restrictions

The following folders:

Interactive Insights and a numbered release
folder, in both BI Launch Pad and CMC, and the
following subfolders:
Agents
Business Results
Details
Documentation
Outbound Contact
Queues
Workspace

The following custom access levels:
Interactive Insights report developer access
level
Interactive Insights report editor access level
Interactive Insights report viewer access
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level
Interactive Insights report basic access level

The following default access restrictions: Static Access Restrictions
Dynamic Access Restrictions

The following objects:

More than forty reports in the Agents, Business
Results, Details, Outbound Contact, Queues,
and Callback folders.
One workspace in the Workspaces folder.
One PDF document: the Genesys Interactive
Insights Universe Guide.
Ten measure maps (that illustrate the relationships
among measures)
One universe: GI2_Universe
One connection: GI2_GIM_DB
The connection object is irrelevant to your
environment, and you can safely ignore it.

Refer to the "Promotion Management" chapter in the relevant Business Intelligence Platform
Administrator Guide for information on how to use Promotion Management. Refer to the Genesys
Interactive Insights Universe Guide for a complete listing and descriptions of the reports.

Verifying Elements
You can invoke the BusinessObjects Central Management Console (CMC) to verify that these
elements have been deployed (under Connections, Folders, Access Levels, and Universes, and
Users and Groups). The LCMBIAR file also contains objects (such as measures, dimensions, and
filters) which are imported using the Import Wizard, but the deployment of these elements is not
reported on the wizard’s summary page. The following section (Viewing the GI2 Reports and
Universe) describes an alternate way to verify the import.

Viewing the GI2 Reports and Universe
When you have successfully installed GI2, you can view the GI2 universe in the Information Design
Tool and the GI2 reports in BI Launch Pad to confirm that all the options you selected during
installation were installed. Keep in mind, however, that additional setup is required to actively use the
report and universe elements. The additional steps for setting up the environment are described in
After Installation, What Additional Steps Do I Perform?.
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Viewing the Universe

The GI2 Universe in the Information Design Tool

The figure The GI2 Universe in the Information Design Tool shows a cutaway of the GI2 universe
Information Design Tool. Refer to BI Documentation to learn more about the Information Design Tool.

Viewing the GI2 Reports

The GI2 Reports in BI Launchpad

The figure The GI2 Reports in BI Launchpad shows the Interactive Insights folder, its subfolders,
and some of the queue-based GI2 reports in BI Launch Pad when expanded. The Documentation
folder contains the Genesys Interactive Insights Universe Guide and several maps that illustrate
relationships between measures:

• If you manually imported the universe, the contents of the report subfolders varies depending on the
selections you made during importation otherwise.

• If the installation routine imported the universe and reports, all of the reports will be imported to the
repository.

You can access GI2 reports using BI Launch Pad (BI 4.1 deployments). Refer to BI Documentation for
information about how to use these tools.

The report and documentation subfolders are stored within a release-specific subfolder of the
Interactive Insights root folder (such as Interactive Insights > 8.5.0). This folder structure enables
you to retain any customizations that you applied to previous GI2 universes. Text references and
screen shots depicted throughout this documentation may not show the complete path, or may show
a release number that differs from your release of GI2.
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GI2 Versioning

Both the GI2 universe and all reports are labeled with a version number, which serves to identify the
GI2 version of reports and the version of the universe. This can be important in the event that you
initiate requests to Genesys Customer Care or have correspondence with other Genesys
departments. This versioning might be further useful to your universe and report designers in
distinguishing reports from other GI2 releases.

Determining the Version of the Universe

Checking the Universe Version

The GI2 universe defines the GI2_UNIVERSE_VERSION parameter to identify the version of the
universe, which you can find in the Query Script Parameters dialog box:

1. In the Information Design Tool, retrieve the universe, and click Business Layer.
2. Select GI2_Universe on the Business Layer objects tree.
3. Click Parameters.

Genesys recommends that you not change the version-number parameter value.

The version number that is shown in the figure Checking the Universe Version might not match
your version of the GI2 universe.
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Determining the Version of a Report

Checking the Report Version

The Description tab of each GI2 report provides the GI2 version associated with the report, as
shown in the Figure Checking the Report Version. This version number also appears after the
descriptions of the measures that are used within the report. Genesys recommends that you not
change its value.

The version number that is shown in the figure Checking the Report Version might not match your
version of the GI2 universe.

Next Steps

After you have installed GI2, perform the additional steps that are described in After Installation,
What Additional Steps Do I Perform? to ready the universe for report users.
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After Installation, What Additional Steps Do
I Perform?
After you have installed Genesys Interactive Insights (GI2), you must manually perform additional
setup steps before you operate the GI2 reports.

Readying Genesys Info Mart for Aggregation

A Genesys Info Mart 8.5 installation that has the Reporting and Analytics Aggregates (RAA) option
deployed contains the tables and views that are referenced by the GI2 reports. To prepare the
Genesys Info Mart environment for GI2 operation, you must perform additional setup steps, including:

• Reposition the \agg Subdirectory: The GI2 installation routine deploys the \agg subdirectory to the
Interactive Insights root folder. This subdirectory and its contents, however, must be placed in the
Genesys Info Mart root folder in order to be recognized by Genesys Info Mart. Copy this directory to the
Genesys Info Mart root folder.

• Set Aggregation-Related Configuration Options: To enable aggregation, you must appropriately
set aggregation-related configuration options (such as aggregation-engine-class-name, run-
aggregates, and business-specific aggregation thresholds) in the Genesys Info Mart application object
in Configuration Manager. These options are described in the Reporting and Analytics Aggregates
Deployment Guide.

Utility Views Specific to GI2

Running aggregation for the first time executes an internal script against your Genesys Info Mart
database to set up the necessary views that mostly facilitate data processing for the GI2 reports.

Genesys Info Mart Multi-Tenant Environments: For Genesys Info Mart environments that contain
more than one tenant, run RAA with the updateAliases runtime parameter to create tenant views of
GI2 objects. For a description of this parameter and an example of its use, refer to the Reporting and
Analytics Aggregates Deployment Guide and the Reporting and Analytics Aggregates User’s Guide,
respectively.

Customizing BO

Use the procedures in this section to apply, or re-apply, customizations to BO.
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Procedure: After Full Installation
Purpose: The GI2 installation routine silently runs the script gi2_customize_bo.bat/sh to
customize the appearance of BO, which also replaces some files in the BI Tomcat webapps
directory. After installation, complete the following steps to restore the contents of the BI
Tomcat webapps directory.

Steps

1. Stop Tomcat.
2. Delete the directory BOE_TOMCAT_ROOT%\work\Catalina\localhost\BOE
3. Restart Tomcat.

Procedure: After Fix Pack Installation
Purpose: The fix packs that are provided by SAP come with their own installer. The latest
supported fix pack, if any, is provided in the Genesys-provided installation package. This
software provides a patch to BI software that you install manually after BI installation.
Instructions for installing the fix pack are provided with the installation package. If you install
this fix pack after installation of GI2, you must also re-execute the gi2_customize_bo script.
(The gi2_customize_bo.bat (Windows) script is described in What Application Files Are
Installed?)

Steps

1. Execute the gi2_customize_bo script.
2. Stop Tomcat.
3. Delete the directory BOE_TOMCAT_ROOT%\work\Catalina\localhost\BOE
4. Restart Tomcat.

Procedure: Customizing Date and Time Display
Purpose: Optionally, you can configure the date and time values that appear in GI2 reports.
By default, the prompts for dates and times do not save custom values you enter, and reports
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always show default date and time values. To change this behavior, complete the following
steps.

Steps

1. Open the Information Design Tool.
2. In the GI2 universe, enable Keep Last Value for the following date/time related parameters:

Pre-set Day Filter, Pre-set Date Filter, Start Date, End Date, Report Date.
3. Restart the BI server.

Procedure: Customizing GI2 User Rights
Purpose: Use this procedure to manually configure rights that are not provided in the
LCMBIAR file.

Steps

1. Start the Central Management Console (CMC).
2. On the Applications tab, right-click the Central Management Console application element,

and in the context menu, select CMC Tab Access Configuration.
3. In the CMC Tab Access Configuration: CMC dialog box, select Restricted, and click Save.
4. Set the following permissions:

• Inboxes: For each GI2 user, select User Security -> Add Principal, and assign the user
access level Full Control (Owner).

• Personal Folders: For each GI2 user, select User Security -> Add Principal, and assign
the user access level Full Control (Owner).

Setting Up Attached Data

Reports are based on the configuration of user data in your environment—user data that is highly
customizeable within any given environment. To use the GI2 reports without modifying the universe
or measure definitions, you must configure user-data data structures within Genesys Info Mart in a
specific manner.

For a detailed example that demonstrates how to configure user-data data structures, see the
Configuring Social Media User Data section in the Genesys Interactive Insights User's Guide.
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Linking the Universe to Your Data Mart

The GI2 reports call upon measures that were designed using the Information Design Tool. These
measures are predefined in the GI2 universe that you imported but they are not pre-connected to
your specific Genesys data source out of the box. You must define such a connection and assign it
within Information Design Tool so that the reports that reference these measures will pull contact
center data from your Info Mart database.

Important
The GI2_GIM_DB connection that the GI2 installation routine deploys is reserved for
Genesys use. Use or modify this connection only if directed, for example, as described
in Using the Default Connection.

Use the following procedures to link the GI2 Universe to your Info Mart database.

Procedure: Importing the Universe to the Information Design
Tool
Purpose: There are many ways to define database connections. In all cases, however, the first
step is to import the GI2 universe to your local Information Design Tool application, as follows:

Steps

Importing a Universe Into the Information Design Tool
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1. From the Start menu, select SAP Business Intelligence > Information Design Tool.
2. In the Open dialog box, specify the system and user credentials, and click OK.
3. In the Information Design Tool, from the File menu, click New > Project.

The New Project dialog box appears. Enter a Project Name (this is the local project where
your files will be stored while you edit them) and optionally choose a different location.

4. In the Information Design Tool, from the File menu, click Retrieve a Published Universe, and
From a Repository.

5. In the Retrieve Universe dialog box, click Next, select the Interactive Insights folder.
Double-click the release subfolder, and click OK.
The Figure Importing a Universe Using the Information Design Tool shows this dialog box
with the 8.5.0 folder selected.

6. Select the GI2_Universe from the list of available universes, and click Finish.

Next Steps

The Information Design Tool imports the universe and displays its classes,
objects, and table relationships in the Universe Window. This local copy of
the universe is now available on your workstation for viewing and editing
universe elements. Any changes you make to the definitions of universe
elements do not take effect until you publish the universe back to the
repository. See Customizing Measure Definitions and Publishing the
Universe Back to the Repository for further information.

Procedure: Using the Default Connection
Purpose: Use this procedure to update the default GI2_GIM_DB connection to point to your
data source, so that you can use it to link the universe objects to the tables in your Data Mart.
Alternatively, you can create a new connection by following the steps in Defining a New
Connection.

After Installation, What Additional Steps Do I Perform?

Genesys Interactive Insights Deployment Guide 28

https://docs.genesys.com/Documentation/IW/8.5.0/Dep/EnvSetup#CustomizingMeasureDefinitions
https://docs.genesys.com/Documentation/IW/8.5.0/Dep/EnvSetup#ExportingtheUniverseBacktotheRepository
https://docs.genesys.com/Documentation/IW/8.5.0/Dep/EnvSetup#ExportingtheUniverseBacktotheRepository
https://docs.genesys.com/Documentation/IW/8.5.0/Dep/EnvSetup#DefiningaNewConnection
https://docs.genesys.com/Documentation/IW/8.5.0/Dep/EnvSetup#DefiningaNewConnection


Steps

Repository Resources: Insert
Session

Select the GI2_GIM_DB Connection

1. Open the Information Design Tool.
2. Select File > New > Project. Enter the Project Name, and click Finish. A new project is

created, and appears on the Local Projects tab.
3. On the Repository Resources tab, click + (Insert), and select Insert Session as shown in the

Figure Repository Resources: Insert Session.
4. In the System field, enter the BI instance name. Enter the User name (Administrator) and

associated password, and click OK.
5. Open the Connections folder, and select the GI2_GIM_DB connection, as shown in the Figure

Select the GI2_GIM_DB Connection.
6. Click the right mouse button and, in the context menu, select Open.
7. Click Change Driver, select a driver, and enter appropriate connection parameters.
8. Test the connection, then choose File > Save to save the connection.
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9. Close the Connection tab.

Next Steps

Next, publish the universe back to the repository using the steps in Publish
the Universe Back to the Repository.

Procedure: Defining a New Connection
Purpose: Use this procedure to define a new connection, which you can use to link the
universe objects to the tables in your Data Mart. Alternatively, you can reuse the default
connection by following the steps in Using the Default Connection.

Steps

Repository Resources: Insert
Session

MS SQL Connection Parameters
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The Newly Created Connection

1. Open the Information Design Tool
2. On the Repository Resources tab, click Open session, or click + (Insert), and select Insert

Session as shown in the Figure Repository Resources: Insert Session.
The Open Session dialog box appears.

3. In the appropriate fields, enter the BI instance name, the User Name (Administrator), and
associated Password.

4. Click OK.
5. Click + (Insert), and select Insert Relation Connection.

The New Relational Connection dialog box appears.

6. Type a name for the new connection, and click Next.
7. Select the appropriate driver for your database middleware, and click Next.

Note: To create a JDBC connection, you must also configure the JDBC driver. SAP provides more
information, in the 'Creating JDBC Connections' section of the Data Access Guide for SAP
BusinessObjects Business Intelligence platform.

8. Enter appropriate connection parameters.
The parameters available vary depending on the driver type you selected for the connection;
the Figure MS SQL Connection Parameters shows parameters for MSSQL server.

9. Test the connection before clicking Next.
10. Click Finish.

The created connection appears in the list of available connections for the BI server, as shown in
the Figure The Newly Created Connection.

Next Steps

Next, link your connection to the universe by using the steps in Connecting
to the GI2 Universe, and then publish the universe back to the repository
using the steps in Publish the Universe Back to the Repository.
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Procedure: Connecting to the GI2 Universe
Purpose: Once you have created a connection (Defining a New Connection) or changed the
default connection (Using the Default Connection), use this procedure to link the universe
objects to the connection.

Steps

Retrieve Universe

Select the Local Project

1. Open the Information Design Tool

2. Make sure your project is open in the Information Design Tool.
3. In the Repository Resources pane, expand Connections, right-click the connection you want

to link to the universe, and select Create Relational connection shortcut.
The Select A Local Project dialog box appears.

4. Select the project created.
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5. On the Local Projects pane, double-click GI2 Universe.dfx to open it.
6. On the GI2 Universe.dfx pane, click Connection, and in the Connection navigation tree,

right-click the existing connection and select change.
The Change Connection dialog box appears.

7. Select the connection shortcut created in Step 2, and click Finish.
8. Click Save to save GI2 Universe.dfx.

Next Steps

Next, publish the universe back to the repository using the steps in Publish
the Universe Back to the Repository.

Procedure: Publishing the Universe Back to the Repository
Purpose: The changes that you make to the universe are local. To make them available to
others who might run reports, you must publish the universe back to the repository, as follows:

Steps

Publishing Changes Back to the Repository

1. Open the Information Design Tool.
2. In the Repository Resources pane, open the folder: Universes > Interactive Insights >
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8.5.0.
3. Right-click GI2_Universe.unx, and in the context menu select Retrieve Universe, as shown in

the Figure Retrieve Universe.
4. Select the local project you want to publish, as shown in the Figure Select the Local Project.
5. In the local projects pane, open the folder, which has a name in the format retrieval-<date>,

such as retrieval-2016-12-24-19-08-50.
6. Select the GI2_Universe.blx element, click the right mouse button and from the context menu,

select Publish > To a Repository.
7. In the Publish a Universe to a Repository dialog box, for the first step (Check Universe

Integrity) click Next. The next step (Select or create the repository folder where you want to
publish the universe.) appears.

8. Open the folder: Universes\Interactive Insights\8.5.0\, and select GI2_Universe.unx as
shown in the Figure Publishing Changes Back to the Repository.

9. Click Finish.
The message Overwrite published universe? appears.

10. Click Yes, and close the dialog box.
11. From the File menu, select Publish > Publish Connection to a Repository.
12. From the Groups list, select all of the groups to which this connection applies.
13. From the Universes list, select the name of your universe (for example, GI2_Universe).
14. Click OK.

The updated universe—with connection to your data source defined—is now available to the
user groups that you specified.

Manually Setting Up GI2 Access Levels, Groups, and Permissions

The GI2 installation routine silently deploys the GI2 objects that are stored in the insights.lcmbiar
file, and assigns permissions to these and other objects.

As a BI administrator, you can use the Import Wizard to import these objects with their permissions
applied to universe elements (see Manually Importing Objects and Data Elements), or create the
objects yourself from scratch and assign permissions to various objects by following the instructions
in the following four procedures.

Tip
If your installation of GI2 was successful, remove any GI2 objects that exist in the BI
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repository prior to importing the universe manually by using the Import Wizard, so as
to avoid creating duplicate objects (following Step 3 in Additional Manual Steps to
Finish the Uninstall).

Procedure: Setting Up Access Levels
Purpose: If you opt not to run the Import Wizard to deploy the Interactive Insights report
access levels (which are groupings of permissions that are applied to groups and/or users), you
can create them manually as the administrative user within the CMC. GI2 predefines the
following access levels:

• Interactive Insights report developer access level
• Interactive Insights report editor access level
• Interactive Insights report viewer access level
• Interactive Insights report basic access level

Though these access levels correspond to the GI2 groups, the access levels are
progressive—that is, they build upon the access levels of others. Use this procedure to
manually create these access levels.

Steps

1. Within the Central Management Console (CMC), select the Access Levels section.
2. Click Manage > New > Create Access Level.
3. Enter the name for the new access level: “Interactive Insights report developer access

level”.
4. Click OK.
5. Double-click the access level that you just created to open its properties.
6. Under Included Rights, click Add or Remove Rights, select the appropriate rights for each

collection (shown in the Table: Definitions of the Predefined Interactive Insights Access
Levels).

7. Click OK.
8. Repeat Steps 2–7 for the remaining two GI2 access levels.

Table: Definitions of the Predefined Interactive Insights Access Levels

Collection Type Name of
Right D E V B

System Connection Data Access ✓ ✓ ✓ ✓
General General Add objects ✓ ✓
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to folders
that the
users owns

General General Add objects
to the folder ✓ ✓

General General

Copy objects
that the user
owns to
another
folder

✓ ✓

General General
Copy objects
to another
folder

✓ ✓

General General Delete
instance ✓

General General
Delete
instances
that the user
owns

✓

General General Delete
objects ✓

General General
Delete
objects that
the user
owns

✓

General General Edit objects ✓ ✓

General General
Edit objects
that the user
owns

✓ ✓ ✓

General General
Modify the
rights users
have to
objects

✓

General General

Modify the
rights users
have to
objects that
the user
owns

✓

General General
Schedule
document
that the user
owns

✓

Application WebI
Data
Tracking:
Enable for
users

X

Application WebI
Data
Tracking:
Enable

X
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format
display
changes by
users

Application WebI Enable drill
mode ✓ ✓

Application WebI
Enable
formula and
variable
creation

X

Application WebI Enable HTML
Report Panel ✓ X

Application WebI

Enable
interactive
HTML
viewing (if
license
permits)

X

Application WebI Enable Java
Report Panel X

Application WebI
Enable
Query -
HTML

X

Application WebI
Extend
scope of
analysis

✓ ✓

Application WebI Edit this
object ✓

Application WebI

Interactive:
Formatting -
Enable
toolbar and
menus

X

Application WebI

Interactive:
General -
Ability to
hide / show
toolbars

X

Application WebI
Interactive:
General -
Edit 'My
Preferences'

X

Application WebI
Interactive:
General -
Enable right
click menu

X

Application WebI

Interactive:
Left pane -
Enable
available
objects,

X
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tables and
charts

Application WebI
Interactive:
Left pane -
Enable data
summary

X

Application WebI

Interactive:
Left pane -
Enable
document
structure
and filters

X

Application WebI

Interactive:
Left pane -
Enable
document
summary

X

Application WebI

Interactive:
Reporting -
Apply and
remove
existing
alerts

X

Application WebI
Interactive:
Reporting -
Create and
edit break

X

Application WebI

Interactive:
Reporting -
Create and
edit
predefined
calculation

X

Application WebI

Interactive:
Reporting -
Create and
edit report
filter

X

Application WebI
Interactive:
Reporting -
Create and
edit sort

X

Application WebI

Interactive:
Reporting -
Insert and
remove
report, table,
chart and
cell

X

Application WebI View SQL X

Application WebI Web
Intelligence X
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Rich Client:
Save a
document
locally on
the file
system

Application WebI

Web
Intelligence
Rich Client:
Create a
document

X

Application WebI

Web
Intelligence
Rich Client:
Enable a
client to use
it

X

Application WebI

Web
Intelligence
Rich Client:
Export a
document

X

Application WebI

Web
Intelligence
Rich Client:
Import a
document

X

Application WebI

Web
Intelligence
Rich Client:
Print a
document

X

Application WebI

Web
Intelligence
Rich Client:
Save a
document
for all users

X

Application WebI
Web
Intelligence
Rich Client:
Send by mail

X

Content WebI Edit Query ✓
Content WebI View SQL ✓

Content WebI Export the
report's data ✓

Content WebI Refresh List
of Values ✓

Content WebI Refresh the
report's data ✓

Content WebI Save as CSV ✓
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Key:

• D=Developer Access Level
• E=Editor Access Level
• V=Viewer Access Level
• B=Basic Access Level
• A ✓ signifies that the right applies to the indicated access level.
• An X signifies that the right is blocked for the indicated access level.

Procedure: Creating GI2 Groups
Purpose: In addition to the Interactive Insights access levels, the Import Wizard also deploys
GI2 user groups. Use this procedure to create them manually and add users.

Steps

1. In the CMC, select the Users and Groups section and over Group List, right-click New, and
select New Group.
The Create New User Group page appears.

2. In the Group Name field, type Interactive insights report developers.
3. In the Description field, type an appropriate description.
4. Click OK.
5. Select User List.
6. From the Available users or groups list, select Developer and any other user who belongs to

this group, and move your selection to the Selected users/groups list.
7. Click Close to close the user security properties.
8. Repeat Steps 2–7 to create the following user groups: Interactive Insights report editors,

Interactive Insights report viewers, Interactive Insights report basic, Interactive
Insights access restrictions, and finally create Interactive Insights custom access
restrictions as a subgroup of Interactive Insights access restrictions.

To maintain flexibility, permissions (other than the default) are not assigned to the GI2
users or groups. Instead, Genesys recommends that you assign permissions directly to the
objects that users access, as described in Setting Permissions for BI Objects.
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Procedure: Hiding Unused Folders
Purpose: BI 4.1 software includes folders that are not used by GI2. Among them are the
following: Auditing, Report Conversion Tool, and Report Samples. Use this procedure to
hide these folders from users in the GI2 report groups.

Steps

1. In CMC, click the Folders section.
2. For each folder you want to hide, right-click the folder, and select User Security.
3. Click Add Principals. The Add Principals page appears.
4. Select the Group List.
5. From the Available users or /groups list, select the Interactive Insights [*] user groups and

click > to move them to the Selected users or groups list box.
6. Click Add and Assign Security. The Assign Security page appears.
7. Clear the Inherit From Parent Folder and Inherit From Parent Group check boxes, and click

OK.
Because no access levels were explicitly selected, a dialog box appears, prompting you to
confirm this action.

8. Click OK.
CMC returns to the User Security properties of your selected folder and displays the added
groups.

9. Click Close.

With these changes applied to each folder, the folders are invisible to GI2 users. However,
administrative users continue to see the hidden folders.

Procedure: Setting Permissions for BI Objects
Purpose: Use this procedure to manually set permissions on the objects used by GI2,
including the universe, the Interactive Insights folder and connection, and even the BI
Launch Pad and Web Intelligence applications.
The Table Mapping of Access Levels to BI Objects lists the user security properties of
objects that the GI2 installation routine sets. To set these manually, perform the following
steps within Central Management Console (you must be administrative user):
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Steps

1. Set top-level security for root objects or user security for other objects:
• To set top-level security, open the appropriate CMC section (such as Connections, Folders, or

Universes), select Manage > Top-Level Security > All <Objects>.
• To set user permissions, open the appropriate CMC section (such as Connections, Folders, or

Universes), right-click the desired object from that section, and select User Security.

2. Click the Add Principals button, and select Group List.
3. From the Available Users or Groups list box, select the groups indicated for the object (see the

Table below) and move them to the Selected users or groups list box.
4. Click the Add and Assign Security button, either clear or mark the Inherit From Parent

Folder and Inherit From Parent Group boxes as indicated for the object on the Table
Mapping of Access Levels to BI Objects, and apply your changes.
• On the Access Levels tab, select the appropriate access level from the Available Access

Levels list, and move it to the Assigned Access Levels list.
• Apply your changes, and click OK.

5. Click Close to close the user security properties.

Table: Mapping of Access Levels to BI Objects

CMC
Section

Object
Name Principal¹

Inheritance
From Parent

...
Access Level²

...Folder...Group D E V B Full Vw VOD

Connections

<Connections
root
folder>

Developers✓ ✓ ✓ ✓

GI2_GIM_DB

Restrictions✓ ✓ ✓
Basic ✓ ✓ ✓
Developers✓ ✓ ✓ ✓
Editors ✓ ✓ ✓
Viewers ✓ ✓ ✓

Universes

<Universe
root
folder>

Developers✓ ✓ ✓

Interactive
Insights
(folder)

Developers✓ ✓ ✓

GI2_Universe
Restrictions✓ ✓ ✓
Developers✓ ✓ ✓
Editors ✓ ✓ ✓ ✓
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Viewers ✓ ✓ ✓

Application

Web
Intelligence

Restrictions✓ ✓ ✓
Basic ✓ ✓ ✓
Developers✓ ✓ ✓
Editors ✓ ✓ ✓
Viewers ✓ ✓ ✓

BI
Launch
Pad

Restrictions✓ ✓ ✓
Basic ✓ ✓ ✓
Developers✓ ✓ ✓
Editors ✓ ✓ ✓
Viewers ✓ ✓ ✓

Information
Design
Tool

Developers✓ ✓ ✓

Folders

<InfoView
root>

Restrictions✓ ✓ ✓
Basic ✓ ✓ ✓
Developers✓ ✓ ✓
Editors ✓ ✓ ✓
Viewers ✓ ✓ ✓

Interactive
Insights

Restrictions✓ ✓ ✓
Basic ✓ ✓ ✓
Developers✓ ✓ ✓ ✓ ✓
Editors ✓ ✓ ✓ ✓
Viewers ✓ ✓ ✓

Key:
¹ Principals:

• Interactive Insights access restrictions
• Interactive Insights report developers
• Interactive Insights report viewers
• Interactive Insights report editors
• Interactive Insights report basic

² Access Levels:

• D= Interactive Insights report developer access level
• E = Interactive Insights report editor access level
• V = Interactive Insights report viewer access level
• B = Interactive Insights report basic access level
• Full = Full Control
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• Vw = View
• VOD = View On Demand

Setting Data-Access Restrictions for Multi-Tenant Environments

In addition to the permissions that you can set within CMC to control access to various BI repository
elements, you can also set restrictions on user access to data by limiting the objects, rows, query
types, and connections that are available to users through the Universe Design Tool application. BI
defines a restriction as a named group of constraints that can be applied to a group or user account
for a universe.

Through the use of restrictions, administrators can control what data users see in the GI2 reports. Use
this feature if your data source stores data for more than one tenant. For instance, within one
universe, you can define several connections—each of which accesses a different tenant view within
the same Info Mart—and then create and apply connection restrictions to each tenant to ensure that
its users see only the data that is pertinent to that tenant.

The login to Web Intelligence identifies the user (and hence the user group) and the access
permissions that are assigned to that user within the repository; the restriction defines which
connection the user can use to access data within a specific universe. No changes to the definitions
of dimensions or measures, for instance, or to the design of the reports are then required to provide
tenant-specific data in your reports.

The benefits of this one-universe approach include:

• Consistency in measure definitions across the enterprise.
• Reduced maintenance costs—having to manage only one universe (instead of one universe per tenant).
• Single source.
• Optimized use of network resources.

Genesys Info Mart supports several methods of configuring multi-tenant environments, including:

• A separate schema for each tenant.
• A separate schema for each group of tenants.
• One database/one schema for all tenants (where each tenant can see other tenants’ data).

Configuration depends largely on the capabilities that are provided by your chosen RDBMS and on
the data access security measures that are established within your enterprise. Please refer to the
Genesys Info Mart Deployment Guide for further information.

For Microsoft SQL 2005 RDBMS, note the following: In the scenario in which a separate schema has
been created within one database for each tenant, you must ensure that individual tenant logins map
to the respective database owner for the tenant schema or that the default schema for each tenant
login matches that of the owner for that schema. Furthermore, this login must not be sysadmin;
otherwise, elements in the GI2 universe might point to an unintended set of objects in the Info Mart
database.
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Procedure: Creating Users and Groups in Multi-Tenant
Environments
Purpose: The steps that are provided in Manually Setting Up GI2 Access Levels, Groups, and
Permissions describe the procedures for creating GI2 users and groups and assigning users and
groups to various repository elements. The naming convention used for the users and groups
and the presentation of the steps is suitable for a single-tenant environment. However, with
the exception of the names that you choose for users/groups, the procedures are identical for
multi-tenant environments.

Steps

1. If you have not done so already, complete the steps that are defined in the following sections to
add GI2 views to each tenant schema (or database, as applicable) and to define connections to
them, respectively: Utility Views Specific to GI2 and Linking the Universe to Your Data Mart.
When you are naming data-source connections (Step 6 of Defining a New Connection), give
them tenant-identifying names, such as Tenant1Connection or GI2_Tenant_Oracle10g.

2. To set up users and groups for your tenants, follow the steps that are provided in Manually
Setting Up GI2 Access Levels, Groups, and Permissions—again, giving them tenant-identifying
names, such as Tenant1 Report Viewers (group) and Tenant1 Viewer (user). The concept of
assigning user and group permissions in CMC to connections (discussed in Setting Permissions
for BI Objects) is different from the concept of assigning connection restrictions to users and
groups within the Information Design Tool. Unlike the Information Design Tool, CMC does not
enable you to define a connections map within one universe to map different data-source
connections to defined users and/or groups.

Profiles in the Security Editor
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Procedure: Creating Profiles to Restrict Access
Purpose: Within the Information Design Tool, use the steps in this procedure to create and
define restrictions in the Security Editor, and apply them to the tenant users and groups that
you created earlier in Creating Users and Groups in Multi-Tenant Environments.

Steps

1. In the Information Design Tool, click Security Editor.
The Figure Profiles in the Security Editor shows the Security Editor.

2. On the Universe/Profiles tree, open the folder where the GI2_universe.unx file is stored, select
GI2_universe.unx, and click Insert Data Security Profile.
The Define Data Security Profile dialog box appears, in which you can create a new
restriction.

3. In the Data Security Profile Name field, enter a suitable name for a restriction for a particular
tenant—for example, Tenant1 Connection Restriction, where Tenant1 is the name of the tenant.

4. Click Edit.
The Define Replacement Connections dialog box appears.

5. From the Replacement Connection list, select the appropriate data-source connection for the
tenant—for example, GI2_Tenant1_MSSQL.

6. Click OK to save the restriction, and OK again to close the Define Data Security Profile dialog
box.

7. Repeat Steps 2 through 6 for each connection restriction that you want to define.
Tip: Because the Define Data Security Profile dialog box does not have an Apply button, you
might want to save your changes periodically by closing the dialog box (clicking OK) and
reopening it, especially if you have several restrictions to define.

8. In the Security Editor, from the list of users and groups on the right, select all of the users whose
access to this universe you want to restrict, and click < to add them to the Users / Groups list.

9. One by one, assign the available restrictions that you created to the appropriate group and/or
user.

10. Click Save on the main menu to save your changes.

Setting Integrated Data Access Restrictions

Data access restrictions are integrated with data access roles. These restrictions control access to
objects within the Info Mart database so that BI users who are members of BI groups with associated
access restrictions see data only for appropriate contact center resource groups (Agent Groups or
Queue Groups that are configured in the Configuration Layer). There are two types of these
restrictions:
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• Static Access Restrictions: Enable you to configure a list of objects for which no data appears when
reports are viewed by users who are members of restricted groups. For example, you can use this
feature to prevent group members from viewing data for 'system' objects (such as Queue/Queue
Groups).

• Dynamic Access Restrictions: Enable you to restrict access to data based on each BI user name and
the attributes you configure to describe the user's geographical location, line of business, or
organizational role. For example, you can use this feature to ensure that a supervisor sees data only
from agents in specified locations, on specified teams.

Custom Data Access Restrictions

You can customize integrated data access restrictions by configuring the following Data Access
Visibility (DAV) attributes, which are available on each object’s Annex tab:

• ORG (Organizational Role)
• GEO (Geographic Location)
• LOB (Line of Business)

You restrict access to data by defining values on the Annex tab, as follows:
• For each Person: BI login, plus one or more DAV attributes
• For each contact center group: one or more DAV attributes

As long as a user has at least one DAV attribute that matches a group, then
that user can see data from that group. For example:

• Agent Group1 has the following annex value: RPT_GEO=Daly City
• Agent Group2 has the following annex value: RPT_GEO=San Francisco
• Agent SuperVisor1 has the following annex value: RPT_GEO=Daly City
• Agent SuperVisor2 has the following annex value: RPT_GEO=San Francisco
• When Agent SuperVisor1 runs a report, the report contains data from Agent Group1, but not data from

Agent Group2. The reverse is true for Agent_Supervisor2.

Data access restrictions use a small amount of system resources, so configuring them can result in a
slight decrease in system performance.

Procedure: Configuring Access Restrictions
Purpose: Define DAV attributes using Configuration Manager, and define access restrictions
using the Information Design Tool.

After Installation, What Additional Steps Do I Perform?

Genesys Interactive Insights Deployment Guide 47



Steps

1. In Configuration Manager, open View > Options, and ensure that Show Annex tab in object
properties is selected.

2. Using Configuration Manager, perform the following steps for each user (Person):
a. If it is not already present, add the RPT section.
b. Within the RPT section, add an option with:

• Option Name = BOE_USER

• Option Value = <username>

c. If they are not already present, add one or more of the following sections:
• RPT_GEO
• RPT_ORG
• RPT_LOB

d. Within each of the sections you added in Step c, assign suitable options. For example, within
the RPT_GEO section, you might add an option and assign it an Option Name that describes
the geographical location of a group, such as Daly City.

Neither Genesys Info Mart nor GI2 processes the Option Value for options in the [RPT_GEO], [RPT_ORG], or [RPT_LOB]
sections, so you can leave the option value blank, and enter only the option name (unless the Configuration Server
installed in your environment requires a value, as is the case in Configuration Server 7.6 and earlier).

3. Using Configuration Manager, perform the following steps for each contact center Group (Agent
Groups and DN [ACD Queue] Groups):
a. If they are not already present, add one or more of the following sections:

• RPT_GEO
• RPT_ORG
• RPT_LOB

b. Within each of the sections you added in Step a, assign suitable options. For example, within
the RPT_GEO section, add an option and give it an Option Name that describes the
geographical location of a group, such as Daly City.

4. Using the Information Design Tool assign Access Restrictions to the relevant BI groups. To apply
more than one access restriction (for example, both the default Static Access Restriction and
Dynamic Access Restriction), you must:
a. Create two or more groups (or create one group, and for the other, use the default group

Interactive Insights access restrictions).
b. Assign one access restriction to each group (using the default access restrictions, custom

restrictions that you create, or a combination of the two).
c. Organize a Group Hierarchy, so that one group is a sub-group of the other. You can assign

priorities to the access restrictions associated with each group, and the BI software applies
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these access restrictions starting with the highest-level priority within the hierarchy.

For more information about working in Genesys Configuration Manager, see Framework
Configuration Manager Help.

Data Access Restriction Configuration Example
This example creates restrictions so that when the user boeuser1 views GI2 reports, the data
in the reports comes only from Agent Group 1 (and agents in that group) and Queue Group
1 (and queues in that group).

1. Log in to Configuration Manager, and in the Annex of cmperson1, create the section RPT with
option BOE_USER=boeuser1 and section RPT_GEO with option Daly City=<any value> as
follows:
[RPT]
BOE_USER=boeuser1
[RPT_GEO]
Daly City=<any value>

2. In the Annex of Agent Group 1, create the section RPT_GEO, and add the option Daly City=
<any value>, as follows:
[RPT_GEO]
Daly City=<any value>

3. In the Annex of Queue Group 1, create the section RPT_GEO, and add the option Daly City=
<any value>, as follows:
[RPT_GEO]
Daly City=<any value>

4. Run Genesys Info Mart and execute one ETL cycle. All data for objects with configured Annex are
added in GIM tables: RESOURCE_ANNEX and GROUP_ANNEX.

Tip
GI2 relies on Interaction Concentrator and Genesys Info Mart to populate the RESOURCE_ANNEX and
GROUP_ANNEX tables. Refer to the Interaction Concentrator Deployment Guide and Genesys Info Mart
Deployment Guide for information about how to configure the population of Annex data (using the
Interaction Concentrator cfg-annex option).

5. Log in to Central Management Console (CMC) as Administrator.
6. Create the user boeuser1, and add the newly created user to the Interactive Insights access

restriction group.
7. Log in to the Information Design Tool as Administrator, and open the Security Editor.
8. In the Security Editor, apply Dynamic Access Restriction to the Interactive Insights access
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restriction group.

The user boeuser1 now sees report data only from Agent Group 1 and Queue Group 1.

Translating the Universe, GI2 Reports, and BI GUI

Genesys provides GI2 product installation packages in several languages, while BI langauge packs
are available from SAP. The steps to install BI language packs are described in the SAP
BusinessObjects Business Intelligence platform 4.1 Installation Guide.

To display the reports and use the universe and BI in a language other than English, complete the
following steps:

Procedure: Translating the Universe, GI2 Reports, and BI GUI

Steps

1. Change the host’s browser locale to match the language you plan to install.

CMC Preferences – Changing the Product Locale

2. Install the target BI language pack (see SAP BusinessObjects Business Intelligence platform 4.1
Installation Guide).

3. In CMC, click Preferences > Administrator. Change the BI product locale as shown in the
Figure CMC Preferences – Changing the Product Locale.

4. Install the GI2 language pack.
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Important
Check the appropriate GI2 Language Pack Release Note to ensure that the release of the language
pack you plan to install is compatible with the installed release of GI2.

The updated universe—with connection to your data source defined—is now available to
the user groups that you specified.

Customizing Measure Definitions

Genesys supports limited customization of the following GI2 measures:

• In the Activity class:
• Avg Handle Time
• Handle Time

• In the BA Customer class:
• % First Response Time Service Level
• % First Response Time Service Level 80

• In the Queue class:
• % Accepted
• % Accepted 80
• Avg Handle Time
• Handle Time

• In the Summarized State class:
• % Occupancy

You can redefine these measures within the Universe Design Tool, as prescribed within each
measure’s properties within the universe. Refer to the Genesys Interactive Insights User’s Guide for
information about how to customize measures. After you have customized measure definitions, be
sure to publish the universe back to the BI repository by following the steps in Publishing the
Universe Back to the Repository.
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How Do I Access GI2 GUIs?
This section provides information about how to access each of the relevant BI application GUIs. If you
require more information than is given on this page, refer to the BI Documentation for detailed
information about how to use these applications.

You can access Genesys Interactive Insights (GI2) reports using Business Intelligence (BI) Launch Pad.
You access the GI2 Universe through the Information Design Tool. You access localized versions of the
GI2 universe and reports using the same applications; however, you must first import localized GI2
elements using the Translation Management Tool (as described in the section Translating the
Universe, GI2 Reports, and BI GUI).

Checking Web Server Status

Checking Web Server Status using Central
Configuration Manager

The Central Management Console (CMC), and Web Intelligence applications can be run only if the
Tomcat Web server (or other web server) is available. If you find that you cannot start these
applications, within the Central Configuration Manager (CCM), check whether the web server is
running. The figure Checking Web Server Status using Central Configuration Manager, for
example, shows a stopped Tomcat server. Right-click the name of the server to restart it.

CCM is accessible only from Microsoft Windows platforms. To open CCM, at the Start menu, navigate
to the program folder where BusinessObjects is deployed, and select Central Configuration
Manager. The default location is:
All Programs › SAP Business Intelligence › SAP BusinessObjects BI Platform 4 ›
BusinessObjects Enterprise

Accessing the Central Management Console

BusinessObjects supports use of the Central Management Console in various browsers, including
Microsoft Internet Explorer and Firefox. You must have the name of the Web server that has been
established by your administrator to start this application, or the complete URL if your administrator
configured it with other than the default parameters and path. Also, you must know the connectivity
parameters of the account authorized to use CMC.
The default path is:
http://webserver:8080/BOE/CMC
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Refer to the BI documentation for more information.

Accessing BI Launch Pad

BI Launch Pad

In BI 4.1, BI Launch Pad is the user interface for accessing, managing, and running the GI2 reports (in
past releases, BI Launch Pad was known as InfoView). BI Launch Pad supports various browsers,
including Microsoft Internet Explorer and Firefox. To start this application, you must have the name of
the Web server that has been established by your administrator, or the complete URL if your
administrator configured other than the default parameters and path. Also, you must have user
credentials.
The default path is:
http://webserver:8080/BOE/BI
The figure BI Launch Pad shows the initial login screen of the BI Launch Pad.

Accessing Reports

In BI Launch Pad, you can access reports by expanding Documents List > Public Folders >
Interactive Insights, and then choosing the installed release, as shown in the figure Accessing
Reports. BI Launchpad offers a tabbed layout, allowing you to open more than one report, and to
switch easily between them. It also allows you to Pin open reports that you frequently use, so that
they are automatically opened when you log in.

For more information, click Help Menu > Help in BI Launch Pad, and see “BI Content Administration”
in the Business Intelligence Platform User Guide, and other BI documentation.
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Accessing Web Intelligence

Web Intelligence is invoked when you run, view, or modify a report from BI Launch Pad. In addition to
the functionality that is provided by BI Launch Pad, Web Intelligence enables you to drill up/down,
respond to user prompts, and edit queries.

Refer to BI documentation for more information about building reports with the SAP BusinessObjects
Web Intelligence.

Accessing the Information Design Tool

In BI 4.1, Information Design Tool is the user interface for viewing the definitions of universe
elements, customizing measures, and creating and assigning Info Mart connections for report users.
To open the Information Design Tool on Windows platforms, from the Start menu, open the program
folder in which BusinessObjects is deployed, and select Information Design Tool.
The default location of this folder is:
All Programs › SAP Business Intelligence › SAP BusinessObjects BI platform 4 Client Tools
For information on how to use this application, press F1 while operating the Information Design Tool,
and see the Information Design Tool User Guide and other BI documentation.

Accessing the Translation Management Tool

Use the Translation Management Tool to manage the localization of universes and their Web
Intelligence documents and prompts. You open the Translation Management Tool on Windows
platforms. From the Start menu, navigate to the in the program folder in which BusinessObjects is
deployed, and select Translation Management Tool.
The default location of this folder is:
All Programs › SAP Business Intelligence › SAP BusinessObjects BI platform 4 Client Tools
For information on how to use this application, press F1 while operating the Translation Management
Tool, and see the Translation Management Tool User Guide and other BI documentation.
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How Do I Migrate GI2 From an Earlier
Release?
This section describes factors you must consider when migrating to the latest release of Genesys
Interactive Insights (GI2). Migration is described in the Genesys Migration Guide.

You do not need to uninstall or reinstall BO/BI software. Nor must you uninstall the prior instance of
GI2. Migrated reports must employ the supported measures or their supported alternate definitions
and these measures must still be supported within the current release.

Interoperability of Software Components

GI2 has many components, all of which must be work together for optimal report operation. The
following table shows the mix of the minimum required versions of each software component for
complete functionality of all of the reports that were offered since the initial GI2 7.6 release.

GI2 Release BO/BI Release Genesys Info Mart
Release RAA Release

7.6.0 3.0 (12.0) 7.6.001.07 N/A
7.6.001 3.0 + Hot Fix (12.0) 7.6.001.07 N/A
7.6.1 3.1 (12.1.0.882) 7.6.003.05 N/A

7.6.2 3.1 (12.1.0.882) Fix
Pack (FP) 1.8 7.6.005.11 N/A

8.0.000.32 3.1 (12.3.0.601) Service
Pack (SP) 3 8.0.000.73 8.0.000.32

8.0.001.03 3.1 (12.3.0.601) SP3 8.0.001.05 8.0.001.03
8.0.001.06 3.1 (12.3.0.601) SP3 8.0.001.05 8.0.001.06
8.0.100.05 3.1 (12.3.0.601) SP3 8.0.100.05 8.0.100.05
8.1.000.12 3.1 (12.3.0.601) SP3 8.1.000.25 8.1.000.12
8.1.001.02 3.1 (12.3.0.601) SP3 8.1.000.25 8.1.001.02
8.1.100.19 3.1 (12.5.0.1190) SP5 8.1.101.05 8.1.100.19
8.1.100.30 3.1 (12.5.0.1190) SP5 8.1.102.02 8.1.100.30
8.1.100.31 3.1 (12.5.0.1190) SP5 8.1.103.03 8.1.100.31
8.1.101.05 3.1 (12.5.0.1190) SP5 8.1.103.03 8.1.100.31
8.1.102.02 3.1 (12.6.0.1596) SP6 8.1.103.03 8.1.100.31
8.1.103.03 3.1 (12.6.0.1596) SP6 8.1.103.03 8.1.100.31
8.1.104.11 3.1 (12.7.0.1983) SP7 8.1.400.12 8.1.104.11
8.1.105.01 3.1 (12.7.0.1983) SP7 8.1.400.12 8.1.405.02
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GI2 Release BO/BI Release Genesys Info Mart
Release RAA Release

8.1.106.02 Platform 3.1
(12.7.0.1983) SP7 8.1.400.12 8.1.405.09

8.1.106.03 Platform 3.1
(12.7.0.1983) SP7 8.1.400.12 8.1.405.09

8.1.300.03 Platform 4.1
(14.1.2.1121) SP2 8.1.103.03 8.1.103.01

8.1.400.17 Platform 4.1
(14.1.2.1121) SP2 8.1.400.12 8.1.400.23

8.1.400.18 Platform 4.1
(14.1.2.1121) SP2 8.1.400.12 8.1.400.25

8.1.400.19 Platform 4.1
(14.1.2.1121) SP2 8.1.400.12 8.1.400.27

8.1.405.02 Platform 4.1
(14.1.5.1501) SP5 8.1.402.07 8.1.405.02

8.1.405.05 Platform 4.1
(14.1.5.1501) SP5 8.1.402.07 8.1.405.09

8.5.000.02 Platform 4.1
(14.1.6.1702) SP6 8.5.003.12 8.5.000.02

8.5.000.02 Platform 4.1
(14.1.6.1702) SP6 8.5.005.18 8.5.001.23

8.5.000.03 Platform 4.1
(14.1.6.1702) SP6 8.5.005.18 8.5.001.25+

Summary of GI2_Universe Changes

This section lists changes made to the universe in GI2 8.5.0 releases.

Refer to the Genesys Interactive Insights Universe Guide for a complete listing and definitions of all
measures.

Given that the universe is continuously evolving, the custom reports that you create by using one
release of GI2 might yield different results if you run these reports with a different release of the GI2
universe. You should confirm that all of the measures in your custom reports (and the classes to
which the measures belong) are still supported in the latest release of the universe.

Migrating Custom Universe and Reports

If you are migrating from a release that used BO XI 3.1 universe format, you can optionally migrate
the UNV universe and reports to the UNX universe (BI 4.1 universe format). Use the information in
this section to migrate the universe and reports, or to make necessary configuration changes if you
do not migrate the universe and reports.
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Procedure: Migrating Your BO XI 3.1 Deployment to BI 4.1
Purpose: Use the information in this section to migrate your custom universe and reports
from BO XI 3.1 (UNV Universe) to BI 4.1 platform (UNX Universe). Before you begin, ensure that
the following servers on the source and destination deployments are shut down, to avoid
inconsistent states in your new BI 4.1 deployment:

• All of the servers in the source deployment, except the Central Management Server (CMS) and
the File Repository Server (FRS).

• All of the servers (including all of the Job Servers) in the destination deployment, except the
CMS, FRS, and the Report Application Server (if you plan to upgrade Crystal Reports documents).

Steps

1. Launch the Upgrade management tool: Start > Programs > SAP Business Intelligence >
SAP BusinessObjects BI platform 4 > Upgrade management tool. Follow the steps that
appear in the Upgrade management tool, which guides you through the process of exporting BI
content (user accounts, groups, folders, reports, universes, security, and other objects) and
upgrading BI. For more information about the upgrade process, see the SAP BusinessObjects
Enterprise Upgrade Guide.

2. Check the UNV universe for cases where a class and dimension (measure) have the same name
(for example, in the GI2 Universe, there is both a class and a dimension named Queue). Open
the UNV universe using the Universe Design tool, and rename each dimension that has such a
naming conflict. For example, in the case of the Queue dimension, change the name to
“Queue-”. Note that, if you attempt to convert the universe with a class and dimension
(measure) having the same name, the following error appears during the conversion of UNV to
UNX: Error converting universe. Ambiguous object path for 'Queue\Queue'...

3. After the Upgrade management tool exports the content from BO XI 3.1 to BI 4.1, use the
Information Design Tool to convert the custom universe from UNV to UNX format manually. Run
the convert procedure with the prompt convert option.

4. For each dimension that you renamed in Step 2, restore the original names (for example, rename
the Queue- dimension to “Queue”).

5. Save and publish the UNX universe to the server.
6. Perform the following steps to update the UNX universe (GI2_Universe standard objects are

shown as examples):
a. Update all conditions to use the new @Prompt() function syntax, except …TimeRange

conditions from the Detail class. The @Prompt function has a new alternative syntax to
take advantage of named parameters. For conditions that use the @Variable() function,
replace the @Variable() function with the @Prompt() function. For example, change
@Variable(“Agent Group:”) to “@Prompt(Agent Group”). For more information, see the
related topic in the Information Design Tool User Guide.

b. Update all …TimeRange conditions from the Detail class to use the new format of the
default values and new data type in @Prompt() function. For example:
@Prompt('Start Time:','DT',,Mono,Free,Persistent,{'Mar 1, 2013 12:00:00 AM'},
User:2)
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c. If the custom universe uses REPLACE_COMMA_BY_CONCAT parameter, you must update the
SQL definitions for objects that use the “,” sign as a concatenation operand. Use the
standard BO function {fn concat()} instead of the comma. For example: {fn concat({fn
concat(@Select(Outbound Contact\Contact Attempt\Campaign),'@')},
@Select(Outbound Contact\Contact Attempt\Campaign Group\Group Name))} Update
the following GI2 universe objects:
• Agent\Activity\State and Reason\Reason Code (in versions older than 8.1.103.03)
• Detail\Agent Detail\State\Reason Code (in versions older than 8.1.103.03)
• Detail\Agent Detail\Ixn State\State (in versions older than 8.1.103.03)
• Outbound Contact\Contact Attempt\Campaign Group
• Outbound Contact\Agent Contact\Campaign Group\Group Name

4. To reassign Web Intelligence documents to the new UNX universe, open the Change Source
dialog box, check mapping for all objects, and remap any that are not correct.

5. If you have Web Intelligence documents that use merged dimensions in a section, table, or in the
other report elements, recreate the merged dimensions and assign them in appropriate report
elements.

6. For any parameterized URLs that have the OpenDocument syntax, update them to use the new
syntax. This is important if those URLs are used in Web Intelligence documents. Parameter
references, including syntax and usage examples, are provided for each OpenDocument URL
parameter in the Viewing Documents Using OpenDocument SAP Product Guide.
Format the URLs as follows:
="<a href=\"../../../../../OpenDocument/opendoc/openDocument.jsp?...
Note that the sWindow parameter is obsolete in BO XI 3.1 and later. Instead, use the HTML
anchor’s target attribute or an equivalent. For example: <a href="..."
target="_blank">...</a>.

7. Verify Custom Access Levels by editing the migrated Custom Access Levels in the CMC. Check
the Name column for levels that have Unknown Rights instead of the description that was given
in BO XI 3.1 (for example, Interactive Insights report basic/viewer/editor/developer
access level). Some Custom Access Levels may have Unknown Rights because InfoView is not
part of BI 4.1 releases, and BI Launchpad, which replaced InfoView, does not offer the same
rights that are available in the application area of the CMC. Some of the Web Intelligence
viewers and functionality have changed, and the related rights do not exist or are no longer
relevant.
You can achieve the same level of restrictions that these Custom Access Levels had in BO XI 3.1
by combining existing rights available in the CMC. For more information, see the SAP white
paper How Security Rights are migrated between 3.x and 4.0.3.

Procedure: Migrating Your BO XI 3.1 Deployment to BI 4.1
Without Converting the Universe from UNV to UNX
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Purpose: Use the information in this section to migrate your custom universe and reports
from BO XI 3.1 to BI 4.1 platform, without converting your Universe from UNV to UNX. Before
you begin, ensure that the following servers on the source and destination deployments are
shut down, to avoid inconsistent states in your new BI 4.1 deployment:

• All of the servers in the source deployment, except the CMS and the FRS.
• All of the servers (including all of the Job Servers) in the destination deployment, except the

CMS, FRS, and the Report Application Server (if you plan to upgrade Crystal Reports documents).

Steps

1. Launch the Upgrade management tool: Start > Programs > SAP Business Intelligence >
SAP BusinessObjects BI platform 4 > Upgrade management tool. Follow the steps that
appear in the Upgrade management tool, which guides you through the process of exporting BI
content (user accounts, groups, folders, reports, universes, security, and other objects) and
upgrading BI. For more information about the upgrade process, see the SAP BusinessObjects
Enterprise Upgrade Guide.

2. For any parameterized URLs that have the OpenDocument syntax, update them to use the new
syntax. This is important if those URLs are used in Web Intelligence documents. Parameter
references, including syntax and usage examples, are provided for each OpenDocument URL
parameter in the Viewing Documents Using OpenDocument SAP Product Guide. Format the URLs
as follows:
="<a href=\"../../../../../OpenDocument/opendoc/openDocument.jsp?...
Note that the sWindow parameter is obsolete in BO XI 3.1 and later. Instead, use the HTML
anchor's target attribute or an equivalent. For example: <a href="..."
target="_blank">...</a>.

3. Check reports for cases where drilling up from an original dimension to the next aggregation
level causes report sections to be populated by the text #MULTIVALUE, instead of by the
expected data. This occurs because the layout of some reports define section breaks that are
appropriate only to the original aggregation level (dimension) designed for the report. These
section breaks do not accommodate drilling operations.
For example, the Agent Interval Based Report has a section break on Agent Name. As a result,
drilling up to Agent Group does not redefine the section break to occur on agent groups, and
reports for drilled aggregation levels display the result #MULTIVALUE. To prevent this, disable drill
up/down operations from the section dimension of the report. For example, to disable drilling for
Agent Interval Based Report:
a. Open the report in design mode.
b. Change the following formulas in the Agent Name section:

From =NameOf([Session Query].[Agent Name]) to =NameOf([Session Query].[Agent
Name])+""
and
From =[Agent Name] to =[Agent Name]+""

4. The GI2 reports Abandon Delay Report and Speed of Accept (hours/seconds) Report have
incorrect legend colors, and graphical elements are incorrectly positioned on the chart. To
prevent this, make the following changes:
a. Assign TimeRangeKey dimension to the Category Axis.
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b. In the Category Axis, under Layout, turn off Show Labels.
c. In the Category Axis, change the Custom Title value to: (=" ST 1 ST 2 ST 3 ST 4 ST 5

ST 6 ST 7 ST 8 ST 9 ST 10")

5. Verify Custom Access Levels by editing the migrated Custom Access Levels in the CMC. Check
the Name column for levels that have Unknown Rights instead of the description that was given
in BO XI 3.1 (for example, Interactive Insights report basic/viewer/editor/developer
access level). Some Custom Access Levels may have Unknown Rights because InfoView is not
part of BI 4.1 releases, and BI Launchpad, which replaced InfoView, does not offer the same
rights that are available in the application area of the CMC. Some of the Web Intelligence
viewers and functionality have changed, and the related rights do not exist or are no longer
relevant. You can achieve the same level of restrictions that these Custom Access Levels had in
BO XI 3.1 by combining existing rights available in the CMC. For more information, see the SAP
white paper How Security Rights are migrated between 3.x and 4.0.3.

After Migration from BO XI 3.1 to BI 4.1

For any issues you encounter after migration, see the Known Issues and Recommendations section in
the Genesys Interactive Insights Release Notes.

Changing the Source for a Report’s Main Query
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Selecting a Universe for the Query

Mapping Source and Target Objects

Procedure: Linking the Most Recent Universe to Custom
Reports
Purpose: The procedure for migrating custom reports that were designed using a prior release
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of GI2 to the 8.x release consists of two steps:

• Rename report measures to the names that are used in the latest universe, if any have changed.
• Link the report to the latest universe. This requires that you manually link the associated

universe for each report to point to the new universe. This is accomplished within Web
Intelligence and is described in the following procedure.

Steps

1. Open your custom report in Modify mode.
2. Click Data Access, and on the Tools tab, click Change Source.
3. In the Change Source list, select Query. The Change Source Wizard dialog box appears.
4. Select the desired universe from the appropriate release-specific subfolder of GI2, enable the

option Apply changes in all queries sharing the same data source, and click Next.
You can distinguish the universe of one release from another by the folder in which it is stored or
by its version number; for more information about determining the version of the universe, see
Viewing the GI2 Reports and Universe.
You can expand the width of the Universe dialog box to view the full path.

5. On the Change Source dialog box, shown in the figure Mapping Source and Target Objects,
click Next to have BusinessObjects map target objects to source objects. Under some
circumstances, you will need to map a measure that existed from a prior release to a completely
new measure in the current release. Such is the case, for example, for customizations that you
might have made to the Agent Inbound Call Handling VQ Report that was released with the
initial GI2 7.6.0 release. The "...by VQ" measures were subsequently discontinued and replaced
by other measures. Measure descriptions in the Genesys Interactive Insights Universe Guide
include the name(s) that you used in prior releases if they differ from the current release.

6. Save the report and refresh its data.
7. Repeat the steps in this procedure for each of the reports that you customized.

Procedure: Checking Universe Relationships
Purpose: To check that none of your custom reports are still associated with the prior
universe, use the Check Relationships tool that is provided within the BO Central Management
Console.
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Steps

Object Relationships to the Universe

1. From CMC, select Universes, and in the navigation tree, navigate to the universe from which
you migrated.

2. Right-click the GI2 universe (for example, GI2_Universe). From the context menu that appears,
select Tools > Check Relationships. BO displays the object relationships that are associated
with the selected universe, including the immediate folder that is storing it, all defined
connections from the universe to the data mart, and any reports that access data using universe
elements. The figure Object Relationships to the Universe illustrates a resultant screen that
shows six reports that are still tied to the universe. If any custom reports remain among the
listing, migrate them to the newer universe, as previously described.
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How Do I Uninstall GI2?
Use the installation utility that is provided with Genesys Interactive Insights (GI2) to uninstall the
application. This wizard-driven utility removes the majority of files that are deployed during GI2
installation, and removes the application instance from the Microsoft Windows registry, however, it
does not remove all traces of GI2, such as the GI2 universe or the GI2 reports. You can optionally
perform additional manual steps to remove log files, objects, supporting applications and other data.

Uninstall GI2

The following two procedures describe how to uninstall GI2 from Windows or Unix:

Procedure: Uninstall GI2 on Windows deployments
Purpose: Uninstall GI2 from Windows, using either the GI2 setup.exe file or the Windows
Add/Remove Programs utility.

Steps

1. From the GI2 installation package, double-click the setup.exe file.
2. From the Welcome page, click Remove.

OR

1. In the Windows Control Panel, double-click Add/Remove Programs.
2. Select the appropriate GI2 application: Genesys Interactive Insights 8.x.
3. Click Add/Remove.

Next Steps

This procedure deletes all of the deployed files in the GI2 directory and the
program instance in the Microsoft Windows registry. Any additional files that
have been placed in this directory after initial deployment, such as the
generated deploy_unv_rep.log file and any personal files, remain.
Next, perform the additional steps in Additional Manual Steps to Finish the Uninstall to
complete the uninstallation.
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Procedure: Uninstalling on Unix deployments
Purpose: Uninstall GI2 from Unix.

Steps

1. Delete the GI2 folder.

Additional Manual Steps to Finish the Uninstall

Procedure: Additional Manual Steps to Finish the Uninstall
Purpose: After removing the GI2 application, perform each of the following steps to complete
the uninstallation of GI2:

Steps

1. In the directory in which GI2 is installed, delete the installation’s log file
(gi2_deploy_unv_rep.log).

2. Delete the GI2 directory. The default location of this directory is: C:\Program Files\GCTI\
Genesys Interactive Insights

3. Open the Central Management Console, and delete the following objects from the BI repository:
• The GI2 universe:

• GI2_Universe
This action deletes any custom measures that you might have created as well as those
that are provided by Genesys.

• The Interactive Insights folder:
• Genesys Interactive Insights This action deletes all subfolders and any custom reports

that you might have created and stored within this folder as well as those that are
provided by Genesys.

• The Genesys-provided database connection:
• GI2_GIM_DB

• The GI2 user groups, if you created these manually. Note that this action does not delete the
users that are assigned to the groups:
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• Interactive Insights report developers
• Interactive Insights report editors
• Interactive Insights report viewers
• Interactive Insights report basic
• Interactive Insights access restrictions

• The GI2 users, if you created these manually:
• Developer
• Editor
• Viewer
• Basic

• The GI2 access levels, if you created these manually:
• Interactive Insights report developer access level
• Interactive Insights report editor access level
• Interactive Insights report viewer access level
• Interactive Insights report basic access level

4. Remove the following job:
• Promotion Management -> Promotions Jobs -> <Release>

5. (Optional) On the computer(s) used to import and export the universe, in the
Users\...\businessobjects\bimodeler_14\workspace directory, delete both of the following:
• The universe file: GI2_universe.unv.
• The universe folder: GI2_universe. (The default universe directory is:

C:\Users\<username>\.businessobjects\bimodeler_14\
workspace\<project_name>\retrieval-<timestamp>.)

These manual steps complete the uninstallation of GI2 from your computer. To go one step
further and uninstall the supporting applications and underlying data for GI2, complete the
steps in Uninstalling the Supporting Applications and Data.
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Uninstalling the Supporting Applications and Data

Procedure: Uninstalling the Supporting Applications and Data
Purpose: Remove the applications that are provided with the BI suite and the data that is
stored in your Info Mart.

Steps

1. To uninstall BusinessObjects Enterprise, refer to the “Uninstalling BusinessObjects Enterprise”
chapter in the SAP Business Intelligence 4.1 Installation Guide for Windows (for UNIX).

2. To uninstall the aggregation engine that creates and populates the AGT_* tables, refer to the
Reporting and Analytics Aggregates Deployment Guide.
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What Application Files Are Installed?
The Genesys Interactive Insights (GI2) installation routine creates a root folder that contains the
LCMBIAR file of the GI2 universe and supporting files. If you selected a default location for the
installation routine to deploy the GI2, the root folder is:

• The C:\Program Files\GCTI\Genesys Interactive Insights directory on Windows platforms.
• The directory that you specified upon installation on UNIX platforms (in How Do I Install GI2 on UNIX?).

The following table describes the files and subfolders found in the root folder:

Contents of the Root Folder
File Name Description

gi2_customize_bo.bat (Windows)
gi2_customize_bo.sh (UNIX)

Script that customizes the appearance of BI
software with Genesys-specific images and Java
Server Pages (JSP) that encompass the Genesys
design.

gi2_deploy_main.bat (Windows)
gi2_deploy_main.sh (UNIX)

Script that calls the following scripts: gi2_setenv,
gi2_customize_bo, gi2_deploy_unv_rep,
gi2_deploy_sum

gi2_deploy_unv_rep.bat (Windows)
gi2_deploy_unv_rep.sh (UNIX)

This script calls the SAP Promotion Management
Utility to deploy the GI2 elements into the BI
repository using an .lcmbiar file.

gi2_setenv.bat (Windows)
gi2_setenv.sh (UNIX)

Script that sets BI environment variables for
connection to the BI repository, based on values
that you specified during GI2 installation or that
you supply manually. Other scripts rely on the
contents of this script to connect to the BI
repository.
Note: Because this file contains the unencrypted password to
CMS, after installation, consider editing it to remove the
password, if you are concerned about security.

insights.lcmbiar
File that contains an export of the GI2 universe,
reports, PDF documents, measure maps, folders,
users, groups, and their permissions.

ip_description.xml File that lists the contents of the installation
package.

read_me.html File that contains general information about the
installation package.

agg (subfolder)

Subfolder that contains files that support the
Reporting and Analytics Aggregates (RAA) component of
Genesys Info Mart. Refer to the Reporting and Analytics
Aggregates Deployment Guide for descriptions of the files in this
folder.

com (subfolder) Subfolder that contains customization files.
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conf (subfolder)
Subfolder that contains the configuration file biar
properties, which is generated when the
gi2_deploy_unv_rep.bat/sh script runs during
installation.

res (subfolder)
Subfolder that contains additional customization
files, such as JavaServer Pages and other
supporting files.
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What Additional Resources Are available?

Genesys Info Mart

Documentation for Genesys Info Mart is available on the Genesys Documentation website:

• Genesys Info Mart Operations Guide, for information about Genesys Info Mart jobs such as
Job_AggregateGIM, and the Genesys Info Mart Manager, which you can use to manage Genesys Info
Mart jobs.

• Genesys Info Mart Deployment Guide, for information about configuring the Genesys Info Mart and
Interaction Concentrator servers to recognize user data.

Reporting and Analytics Aggregates

Documentation for Reporting and Analytics Aggregates (RAA) is available on the Genesys
Documentation website:

• Reporting and Analytics Aggregates Deployment Guide, which describes the runtime parameters and
configuration options mentioned in this document.

• Reporting and Analytics Aggregates User’s Guide, which describes the different modes of running
aggregation, the aggregation hierarchies, and how to configure Reporting and Analytics Aggregates
(RAA) to aggregate data based on these user-defined dimensions.

• The Physical Data Model documentation for your RDBMS, which describes the aggregate tables and
subject areas:
• Reporting and Analytics Aggregates Physical Data Model for a Microsoft SQL Server Database

• Reporting and Analytics Aggregates Physical Data Model for an Oracle Database

• Reporting and Analytics Aggregates Physical Data Model for a PostgreSQL Database

Genesys Interactive Insights

Important
Genesys Interactive Insights (GI2) 8.5 entered End of Life (EOL) on January 25, 2019.
It enters End of Maintenance on July 28, 2020, and reaches End of Support on January
24, 2021. If you have questions, contact your account representative. GI2 is replaced
by Genesys CX Insights.

What Additional Resources Are available?

Genesys Interactive Insights Deployment Guide 70



Documentation for Genesys Interactive Insights (GI2) is available on the Genesys Documentation
website:

• Genesys Interactive Insights Deployment Guide, which will help you install, start, stop, and uninstall the
Genesys-provided image of BI and the GI2 reports and universe.

• Genesys Interactive Insights Universe Guide, which describes, in detail, the reports and measures that
are provided in the GI2 release.

• Genesys Interactive Insights User's Guide, which includes a report- customization example that displays
aggregated results that are sectioned by your own custom user data.

BusinessObjects Business Intelligence Platform 4.1

Documentation for BusinessObjects Business Intelligence Platform 4.1 (BI) is provided by SAP (see BO
Documentation):

• Business Intelligence Platform User Guide—SAP BusinessObjects Business Intelligence Platform 4.1
Support Package

• Business Intelligence Launch Pad User Guide—SAP BusinessObjects Business Intelligence Platform 4.1
Support Package

• Information Design Tool User Guide—SAP BusinessObjects Business Intelligence platform 4.1 Support
Package

Genesys

Additional documentation for Genesys products is available, as follows:

• The Genesys Glossary provides a comprehensive list of the Genesys and computer-telephony
integration (CTI) terminology and acronyms.

• Genesys Migration Guide, available on the Genesys Documentation website, provides documented
migration strategies for Genesys product releases. Contact Genesys Customer Care for more
information.

• Release Notes and Product Advisories for this product, which are available on the Genesys
Documentation website.

Information about supported hardware and third-party software is available on the Genesys
Documentation website in the following documents:

• The Genesys Interactive Insights page in the Genesys Supported Operating Environment Reference
Guide

• Genesys Supported Media Interfaces Reference Manual

• Genesys Hardware Sizing Guide, which provides information about Genesys hardware sizing guidelines
for the Genesys 8.x releases. For additional system-wide planning tools and information, see the
release-specific listings of System-Level Documents on the Genesys Documentation website
(docs.genesys.com).
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Genesys product documentation is available on the:

• Genesys Customer Care website
• Genesys Documentation website
• Genesys Documentation Library DVD, which you can order by email from Genesys Order Management

at Genesys Order Management.
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